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1 Introduction

1.1 The model

A spill and subsequent vaporisation of a liquid cryogen or volatile caused by the failure of a 
containing vessel presents a potentially serious hazard to the gas industry. Liquids such as liquefied 
natural gas (LNG), liquefied petroleum gas (LPG) and others are routinely stored at low 
temperatures and on their release to the atmosphere they boil or evaporate depending on their 
temperature relative to the ambient air. Such liquids flow across the ground or other substrate 
surrounding the containing vessel, extracting heat from the underlying surface which provides the 
energy to drive the vaporisation. As the liquid spreads, the size of the liquid pool changes and the 
vaporisation rate alters accordingly and such information is essential for calculating the subsequent 
dispersion of the cold vapour. In many circumstances the containing vessel is surrounded by some 
mitigating measure such as the presence of a bund and the flow of the liquid and its interaction with 
the bund wall presents a formidable prediction problem. The Liquid Spill Modelling System 
(LSMS) is a computer code developed by Cambridge Environmental Research Consultants Ltd 
(CERC) to predict the spreading and vaporisation of such a liquid spill. LSMS has been developed 
for sponsors from the gas and safety industries: the Gas Research Institute (US), BG, Gaz de France, 
and the UK Health and Safety Executive.

1.2 Computer implementation

LSMS has been implemented for Windows 3.1, Windows 95 and Windows NT. The package 
consists of an interface and a model engine. The interface allows the user to set up problems, launch 
simulations and view the output produced. The model engine is a separate program which carries 
out the simulations in the background. This allows the user to continue with other tasks while the 
simulations proceed.

1.3 Other documentation

1. The LSMS Final Report (CERC report number FM140/95/1) describes the underlying 
mathematical model and its implementation as a computer code. It discusses the capabilities of 
the model and gives examples from runs of the model.
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2 Getting started

2.1 Document structure and conventions

The following conventions apply to this manual:

 Text which is entered into the LSMS interface is shown in Courier as follows: example text

 Text which is part of the LSMS interface, such as a caption for an input item, is shown in Arial 
as follows: Source Radius

 Keys for the user to press are shown in small capitals as follows: SPACEBAR

 The LSMS interface has been divided into basic features and advanced features. It is 
recommended that the advanced features are avoided in normal use of LSMS, since these 
features require a more detailed understanding of the model. In general the user is advised to 
consult the LSMS Final Report before making use of any advanced feature. It is possible to hide 
the advanced features – see Section 6.1.6. In this manual advanced features are explained in grey 
boxes, as shown below:

Advanced Feature

The details of advanced features will be explained in boxes like this one.

2.2 Minimum system requirements

 An Intel 80386, 80486 or Pentium processor

 Microsoft Windows 3.1, Windows 95 or Windows NT

 10 Mbytes of hard disk space

 A 3 ½” disk drive (for installation)

 Recommended RAM: 5 Mbytes under Windows 3.1, 8 Mbytes under Windows 95 or NT

LSMS can be used under Windows 3.1, Windows 95 or Windows NT. However there are some 
advantages under Windows 95 and Windows NT. In particular the simulations can be carried out 
significantly faster under these operating systems than under Windows 3.1.

2.3 Installing and starting LSMS

2.3.1 Installation

The following steps can be carried out under DOS, using the Windows File Manager or using the 
Windows 95 Explorer:

1) Keep a safe copy of your installation disks.

2) Create a directory to hold LSMS, e.g. C:\LSMS. This is the home directory.

3) Copy all the files from disks 1 and 2 to the home directory (the files are EXE.EXE, DLL.EXE, 
HLP.EXE, VBX.EXE and INSTALL.BAT).

4) Run the copy of INSTALL.BAT created in (3), e.g. type the DOS commands



Section 2: Introduction

- 3 -

C:

CD \LSMS

INSTALL

5) Once LSMS is installed and you have checked it runs (see Section 2.3.2), you can save disk 
space by deleting EXE.EXE, DLL.EXE, HLP.EXE and VBX.EXE from the home directory.

2.3.2 Starting LSMS

In order to run LSMS, the user needs to run the LSMS.EXE executable. This can be achieved in 
different ways, outlined below – the first two rows are alternatives for running LSMS, while the 
third row provides a shortcut to running LSMS. In these examples it is assumed that the home 
directory is C:\LSMS.

Windows 3.1 Windows 95 Windows NT 3

From the Program Manager, 
choose Run from the File menu. 
Type in the command line 
“C:\LSMS\LSMS” and select OK.

Choose Run from the Start
Menu. Type in the command 
line “C:\LSMS\LSMS” and 
select OK.

From the File Manager, find the
file LSMS.EXE in the home 
directory and double-click it 
with the mouse to run it.

From the Explorer, find the file 
LSMS.EXE in the home 
directory and double-click it 
with the mouse to run it.

From the File Manager, find the
file LSMS.EXE in the home 
directory and double-click it 
with the mouse to run it.

A new icon for the program can 
be created under Program 
Manager. First choose New
from the File menu. Select 
Program Group and select OK. 
Type in “LSMS (1.0)” as the 
Description and select OK. Now 
choose New from the File menu 
again. Select Program Item and 
then select OK. Type in 
“LSMS (1.0)” as the Description
and “C:\LSMS\LSMS.EXE” as 
the command line.

LSMS can be added to the Start
menu as follows. From the 
Explorer, find the file 
LSMS.EXE in the home 
directory. Use the mouse to 
drag it onto the Start button 
Alternatively,  use the mouse to 
drag it onto the desktop – this 
will create a shortcut to LSMS 
on your desktop.

A new icon for the program can 
be created under Program 
Manager. First choose New
from the File menu. Select 
Program Group and select OK. 
Type in “LSMS (1.0)” as the 
Description and select OK. Now 
choose New from the File menu 
again. Select Program Item and 
then select OK. Type in 
“LSMS (1.0)” as the Description
and “C:\LSMS\LSMS.EXE” as 
the command line.

The first time LSMS is used on a particular machine, it will ask you to confirm whether the 
operating system is 16-bit or 32-bit, as this determines whether the slower or faster version of the 
model can be used. Windows 3.1, 3.11 and so on are 16-bit operating systems; Windows 95 and 
Windows NT are 32-bit operating systems.
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3 Basic use of LSMS

3.1 General Windows features

The interface is Windows-based, and follows Windows conventions in its overall appearance and 
functionality. This section outlines some general issues for the use of the interface. Please see your 
Windows manuals or help files for further information.

Figure 1 The LSMS interface with the File menu open

3.1.1 The menu bar

The main LSMS window has a menu bar at the top, below the title bar, containing a number of 
menus. Each menu contains a list of commands, which are actions you can carry out in Windows. 
To choose a menu name or a command, you click it once with the left mouse button. Clicking a 
command carries out an action. Menu items with an arrow to the right, such as Print… in Figure 1, 
will produce sub-menus when selected. These sub-menus contain further lists of commands.
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3.1.2 The help bar

The main LSMS window has a help bar at the bottom. This gives you information about the part of 
the interface you are currently using in the form of a short description of the item. If you are 
entering a numeric value, the maximum and minimum permissible values will be displayed, and you 
will be prevented from entering values outside this range. In Figure 1, the help bar is giving details 
for the source radius, which can be between 0 m and 100 m.

3.1.3 Enabled and disabled items

Items in the interface can either be enabled, in which case they are available for use, or disabled, in 
which case they cannot be used. Disabled items appear grey rather than black. For example, in 
Figure 1 the View/Edit Source button is disabled since the source type is not user-defined.

3.1.4 Text boxes

Text boxes allow you to enter text data. When you 
move to an empty text box, an insertion point (a 
blinking vertical cursor) appears. The text you type 

appears at the insertion point. Each text box is accompanied by a caption which explains the 
significance of the text in the box. Here, it is the temperature of the ground in kelvin. Text boxes 
which cannot be edited appear dimmed.

3.1.5 List boxes

List boxes allow you to choose one item from a list of 
choices. The list box shown allows you to choose a liquid 
for the simulation. This is a drop-down list box, so it 
normally appears as a rectangular box containing the 
current selection; however, when you select the box, the 
list of available choices appears. If there are more items 
than can fit in the box, scroll bars are provided.

3.1.6 Check boxes

Check boxes allow you to set or clear an option. When a check box is set it 
contains an X. You can set or clear a check box by clicking it with the mouse, 
or by pressing the SPACEBAR, provided the checkbox is selected. If it is 

selected, it will have a dashed box around it, as shown here.

3.1.7 Radio buttons

Radio buttons represent a group of mutually exclusive options, 
i.e. you can select only one option at a time, and if you select a 
new option, the previous one becomes unselected. The 
selected option contains a black dot. Names of options which 
cannot be selected appear dimmed. In this example, the 
substrate type has been selected as Homogeneous / Impermeable.



Section 3: Basic use of LSMS

- 6 -

3.1.8 Command buttons

You choose a command button to initiate an action. Unavailable buttons 
appear dimmed. The currently selected button has a border that appears 
darker than that of other buttons, and you can initiate the action associated 

with the selected button by pressing ENTER. You can initiate the action associated with any button, 
selected or not, by clicking it with the mouse.

3.1.9 Spin buttons

You move forwards (down) through the list by clicking the down arrow with the mouse.
Spin buttons are used to cycle through an ordered list. You move forwards (back) through 

the list by clicking the up arrow with the mouse. Correspondingly, you move backwards (up) 
through the list by clicking the up arrow with the mouse.

3.1.10 Dialogue boxes

Dialogue boxes are floating screens which appear when you need to supply additional information 
to complete a task. An ellipsis (…) after a menu command indicates that a dialogue box will appear 
when you choose that command. For example, if you choose the Open command on the File menu, 
the dialogue box shown in Figure 2 will appear. In this dialogue box, you specify the name of the 
file you want to open. You choose the OK button to open the file you have chosen. You choose the 
Cancel button to close the dialogue box without opening a file. Several other dialogue boxes have 
OK and Cancel buttons. Cancel will always close the dialogue box and discard any actions or input 
made in it, whereas OK will accept any input from the dialogue box and carry out any appropriate 
action.

Figure 2 The dialogue box for opening files

3.1.11 Message boxes

Message boxes are a particular type of dialogue box. They 
may give you a brief  message, or they may ask you to make 
a simple choice, such as yes or no. For example, this 
message box appears when you choose the New command 
from the File menu. It asks you to confirm that you really 
want to reset the input data to the default values.
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3.1.12 Navigating using a keyboard

Microsoft Windows environments have been developed with a mouse in mind. If you do not have a 
mouse, or prefer not to use it, your Windows user guide and help files will explain how to reproduce 
all mouse actions using a keyboard. Here is a brief guide to some useful actions:

Moving the cursor between input items:

TAB allows you to move the cursor forwards through text boxes and buttons

SHIFT+TAB allows you to move the cursor backwards through text boxes and buttons

RETURN “enters” or accepts the current data page or executes the action of a highlighted 
button

Entering data into a text box:

DELETE will delete the character immediately to the right of the cursor

BACKSPACE will delete the character immediately to the left of the cursor

 CURSOR will move the cursor to the left in the current box

 CURSOR will move the cursor to the right in the current box

HOME will move the cursor to the start of the text in the current box

END will move the cursor to the end of the text in the current box

SHIFT+CURSOR selects text in the direction of the arrow

Radio buttons:

 CURSOR /
 CURSOR

will move the cursor up through the radio buttons for the current item

 CURSOR /
 CURSOR

will move the cursor down through the radio buttons for the current item

In general if a letter in the name of an interface item is underlined, then pressing the ALT key with 
the key for that letter will trigger that interface item. For example the File menu has the letter ‘F’ 
underlined on the screen (as shown in Figure 1). Pressing the ALT and F and together will open the 
menu.



Section 3: Basic use of LSMS

- 8 -

3.2 An outline of  LSMS

The LSMS interface is divided into seven tabbed folders. These tabbed folders allow easy access to 
all input parameters. To swap between folders use the mouse to click on the name of the folder you 
want to reach. The folders are:

Configuration This describes the overall characteristics of the spill. It has three 
subsections, (a) source type, (b) geometry and (c) timings.

Liquid This describes the liquid used in the spill and its initial conditions

Substrate This describes the form of the substrate onto which the spill has 
been made.

Atmospheric This describes the aspects of the atmosphere which affect the spill.

Bund This allows specification of a bund and its properties.

Numerical This describes aspects of the numerical solution of the governing 
equations. It also contains the title for the run.

Plot This allows the user to produce graphs of the results of a 
simulation.

Each LSMS case is identified by a main input file, which has the file extension .LPL. In the rest of 
this manual they will be referred to as LPL files. They contain almost all the input data needed to 
carry out an LSMS simulation1. A full description of the input data is given in Section 4, but it is 
worth noting that each LPL file has a text string associated with it, entered on the Numerical folder, 
and captioned Run Title. It is recommended that you use this to store a brief description of each case: 
this will help distinguish them in the future. LPL files are managed using the commands from the 
File menu (see Section 3.2.1). Simulations are carried out using the commands from the Run menu 
(see Section 3.2.2).

As the simulation proceeds it creates output files to accompany the LPL file. There are various files 
(see Section 9.1 for a complete list),  the most important of which are the log file and the binary data 
files.

 The log file (extension .LOG) is a text file which contains a summary of the progress of the run.

 The binary data files (extensions .LD1 and .LD2) contain the detailed output from the 
simulation. They should only be accessed using the interface. Their size depends on the output 
interval and simulation duration for the case being run, but they can be quite large. If disk space 
becomes short it is a good idea to delete or archive binary files from past simulations. If the LPL 
and SRC files are kept the simulation can always be repeated later.

When the simulation is complete the Plot folder can be used to produce graphs of the simulation 
results, which can be printed or saved for easy retrieval later. The use of the Plot folder is explained 
in detail in Section 5.

                                                
1 The exception is user-defined source data, which is contained in files with the extension .SRC. See Section 4.1.1.
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3.2.1 The File menu

 New resets your input data back to the default values.

 Open reopens an LPL file which has been saved earlier.

 Save saves the current set of input data to an LPL file which may already 
exist.

 Save As saves the current set of input data to a new LPL file.

 Print has two sub-options. Summary prints a summary of the current set of 
input data. Graphs prints the current graphs from the Plot folder. See Section 
5 for details on creating and printing graphs.

3.2.2 The Run menu

Once a case has been created and stored in an LPL file, you can run it in a 
simulation. This is done using the Run menu, pictured at left.

 To run a single simulation choose the Run File command. A dialogue box will appear asking you 
to choose which LPL file to run. If you already have an LPL file open this will appear as the 
default, otherwise you must find the LPL file you want to use. Press RETURN or click the OK
button to begin the simulation.

 It is also possible to run a set of LPL files sequentially, using the Run List command: see Section 
6.3 for details.
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4 The LSMS input data

As noted in Section 3.2, the input data for a problem simulated by LSMS is specified by means of a 
series of folders which appear in the user interface. In this section, each of the six input folders and 
the input parameters required are described in detail.

4.1 The Configuration folder

Figure 3 The Configuration folder

The Configuration folder describes the overall characteristics of the spill. There are three subsections 
to the folder: (1) the source details, (2) the geometry of the domain and (3) the timing for the 
simulation. There are four source types, namely constant inflow, dam break, secondary and user-
defined, and two geometries, either planar or axisymmetric. The choice of source type and geometry 
alters the relevance and meaning of some items on the folder. Correspondingly the main discussion 
below is broken into four sections, one for each source type, and there are subdivisions within these 
for the different geometries where appropriate. See section 4.1.2 for an explanation of the geometry 
items.
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4.1.1 Source types and dimensions

Figure 4 Schematic representation of (a) continuous/user-defined source and (b) instantaneous 
(dambreak) source. The symbols are defined in the text

(a) Continuous inflow source

This represents an inflow with a constant volume flux. You must specify the volume inflow 
[Vol. Inflow (m³/s)] and the horizontal and vertical dimensions. For an axisymmetric geometry, the 
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horizontal dimension [Source Radius (m)] is the radial distance from the origin at which we specify 
the volume inflow, i.e. the volume of liquid per unit time crossing the surface at x = source radius. 
For a planar geometry, the horizontal dimension [Source Length (m)] is the location of the plane at 
which the volume flow rate is specified. You may specify the vertical dimension [Vertical Size (m)] of 
the source if you wish, or alternatively the vertical size of the source can be calculated during the 
simulation2. To set the vertical size explicitly check the Specify Vertical Size checkbox. The Froude 
number3 for your source is displayed in the disabled text box Source Froude No. Please note that the 
underlying assumptions in LSMS mean that a source with a high Froude number may not be 
modelled accurately. You will be warned if you attempt to save an LPL file with a source Froude 
number of more than 2.

Figure 4(a) gives schematic representations of continuous sources for axisymmetric and planar 
geometries: the horizontal dimension is x0, the vertical size of the source is h0, and the volume 
inflow is V7 .

(b) Dambreak source

This represents an instantaneous source, in which a volume of liquid is suddenly released from rest. 
You must specify the size of the initial volume of liquid. For an axisymmetric geometry this volume 
is cylindrical and you must give the radius [Source Radius (m)] and height [Vertical Size (m)]. For a 
planar geometry the initial volume is cuboidal and you must give the length [Source Length (m)] and 
height [Vertical Size (m)], together with the width [Domain Width (m), which is specified in the 
geometry section]. Figure 4(b) gives schematic representations of dambreak sources for 
axisymmetric and planar geometries: the horizontal size is x0, the vertical size is h0, and the domain 
width (for the planar geometry) is b0.

(c) Secondary source

This type of source models the evolution of fluid spilled from a bund. The simulation in which the 
overtopping occurred is known as the primary case. You must choose an LPL file for the primary 
case by using the Choose Primary button, which displays a dialogue box similar to the one displayed 
by the Open command on the File menu.

The configuration of the secondary domain must be defined (see Figure 5 for diagrams of possible 
configurations). You must specify a width for the secondary domain [Width (m)]. This width is w0 in 
Figure 5, and is the length of the part of the perimeter of the primary spill bund over which liquid 
spills into the secondary domain. This value should not exceed the total length of the perimeter of 
the bund wall in the primary spill. Note that it is necessary to take into account the finite thickness 
of the bund wall in calculating the width, i.e. “perimeter” refers to the outer radius of the bund wall. 
Also, when the ground slopes in the primary spill, it is necessary to allow for this when calculating 
the perimeter of the primary source and therefore the value of the width, i.e. if  is the slope angle 
and hb is the bund height then the effective bund radius is increased from rb to rb cos+ hb sin. If 
the secondary domain is an axisymmetric sector, you must specify the semi-angle at the axis of 

                                                
2 The underlying assumption for the latter is that the inflowing liquid has no horizontal momentum. This type of source 
could be used to model liquid welling up from below ground.
3 The Froude number Fr is defined as Fr = u / (g´h)1/2, where u is the velocity of the inflow, h is the source height, and 
g´ is the reduced gravity. On a solid substrate g´ = g, the acceleration due to gravity, but on water g´ = g (w - ) / w, 
where w is the density of water and   is the density of the incoming fluid.
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symmetry [Semi-Angle (°)]. This angle is  in Figure 5. For some configurations, an adjustment to the 
flow rate per unit width by the factor lS defined in Figure 5 is carried out by the model.

Some of the dimensions of the secondary source need to be specified. You cannot specify the 
vertical dimension [Vertical Size (m)] of a secondary spill, but the source radius [Source Radius (m): x0

in Figure 5] is set by default to correspond to the perimeter of the primary spill bund. You should 
not alter this value unless you are considering a different geometry in the secondary domain to that 
in the primary domain4. For a planar secondary domain, the domain width [Domain Width (m): b0 in 
Figure 5] should be specified as usual.

Figure 5 Configurations for a secondary spill

(d) User-defined source

The user-defined source option allows you to design a source in which the flow rate, temperature 
and composition of the inflowing liquid vary throughout the spill. As for a continuous inflow 
source, you must also specify the source dimension. In an axisymmetric geometry you give the 

                                                
4 Or both domains are axisymmetric, but the secondary domain is a sector whose boundaries are not radii of the primary 
domain – see the lower-right part of Figure 5.
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source radius [Source Radius (m)], which is the radial distance from the origin at which you specify 
the volume inflow, i.e. the flow rate is the volume of liquid per unit time crossing the surface at x = 
source position. In a planar geometry you give the x co-ordinate of the source [Source Position (m)], 
which is the distance from the origin at which you specify the volume inflow. You may also specify 
the vertical size of the source [Vertical Size (m)] if you wish, or alternatively the vertical size of the 
source can be calculated during the simulation (see footnote 2 above). To set the vertical size 
explicitly check the Specify Vertical Size checkbox. Figure 4(a) gives schematic representations of 
user-defined sources for axisymmetric and planar geometries: the horizontal dimension is x0, the 
vertical size of the source is h0, and the volume inflow is V7 .

Figure 6 The User-defined source dialogue box

The variation of a user-defined source is controlled by using the View/Edit Source button to launch 
the User-defined source dialogue box, shown in Figure 6. This allows you to control the time-
variation of the source during the simulation. You must always define the flow-rate and temperature 
of the incoming liquid, and if the liquid is multicomponent you must define the composition of the 
incoming liquid as well, by setting the volume fractions of the components.

You define the variation of the source variables by entering a set of time and value pairs for each 
one. During the simulation these sets of time and value pairs will be used to find values at the 
current time. If the current time is between two specified times, linear interpolation will be used to 
find the current value. Once the last specified time has been passed, the value is assumed to remain 
constant at the last value you entered. For example, if only one time and temperature pair is given, 
the temperature of the inflowing liquid stays constant throughout the simulation. Consequently, to 
define a source of finite duration you must specify a final flow-rate of zero explicitly.
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Each variable is edited independently, by choosing the current variable from the list box at the top-
left of the dialogue box. A curve showing the time-variation of the variable is displayed in the 
graph, and the time-value pairs are shown in the list box at the bottom left of the dialogue box. You 
can add a new pair by typing the time and value into the two text boxes, then clicking the Add button 
or pressing RETURN. To edit a time-value pair once it has been added, select it from the list then click 
the Edit button. To delete a time-value pair, select it from the list then click the Delete button. When 
you are specifying the flow-rates, it may be useful to note that the total volume to be spilled is 
calculated and displayed at the top of the dialogue box (as shown in Figure 6).

Once you have entered values for all the variables, click the OK button to return to the main screen. 
If you want to abandon your changes, click the Cancel button. At any time you can use the 
Copy Graph button to copy the graph for the current variable to the Windows clipboard. You can 
then paste an image of the graph from the clipboard into other Windows applications, e.g. for use in 
a report.

The maximum Froude number (see (a) above for the definition of the Froude number) for your 
source is displayed on the Configuration folder in the disabled text box Source Froude No. Please note 
that the underlying assumptions in LSMS mean that a source with a high Froude number may not be 
modelled accurately. You will be warned if you attempt to save an LPL file with a source Froude 
number of more than 2.

4.1.2 Geometry

There are two geometries available for LSMS runs, namely axisymmetric and planar, and the 
geometry is chosen using the Axisymmetric and Planar radio buttons. Axisymmetric geometry means 
that the spill has cylindrical symmetry. Planar geometry means that the flow is unidirectional, as if 
contained within a parallel-sided channel, and uniform across the flow. The spill width in the 
transverse direction must be specified [Domain Width (m)].

4.1.3 Simulation span

The simulation will continue until all the fluid has vaporised or until the maximum duration of the 
simulation is reached [Duration (s)]. It may be advisable to begin with smaller values of the duration, 
say 10s - 100s, to get some idea of the behaviour of a particular case, if this is uncertain, before 
extending it to longer runs. This avoids having unnecessarily long computations and output files for 
all the examples examined. The Output Interval (s) textbox is used to give the time interval between 
successive output of the state of the spill to the main data file. Generally this should be between 
0.1% and 1% of the simulation duration, to avoid the output files becoming too large. Users should 
also bear in mind that the smaller the output interval, the slower the simulation will be. On the other 
hand, a smaller output interval records the evolution of the spill with time in more detail.
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4.2 The Liquid folder

The Liquid folder controls the type of liquid spilled and its initial conditions. It is divided into three 
sections: (1) Liquid Type, (2) Initial State and (3) Bubbles. 

Figure 7 The Liquid folder

4.2.1 Liquid type

The major choice on this folder is the liquid for the spill. The Liquid Type drop-down listbox allows 
you to choose a liquid from the database of predefined liquids. Once a liquid has been chosen, its 
properties can be viewed by selecting the Show Properties button. This displays a dialogue box which 
allows you to inspect the properties of each component of the liquid. The properties cannot be 
edited here, however: to edit the properties of a liquid you must use the liquid database editor (see 
Section 6.5).

4.2.2 Initial state

This part of the folder allows the initial properties of the liquid to be specified. For a dambreak 
release, these represent the state of the initial volume just as it is released. For a continuous source, 
these represent the state of the liquid as it flows into the domain. For a secondary release, the 
properties of the incoming fluid are determined by the primary spill and this section is disabled. For 
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a user-defined source, the initial state of the incoming liquid may vary throughout the spill. This 
variation is controlled by the user-defined source dialogue box, which is accessed from the 
Configuration folder, and consequently the Initial State section is disabled for such sources.

The temperature of the liquid [Initial Temperature (K)] can be specified explicitly, or the liquid can be 
set to its boiling temperature (which is dependent on concentration for a multicomponent liquid) by 
checking the Set to Boiling checkbox. It is recommended that spills of cryogenic liquids are modelled 
using this feature to set the initial temperature to the boiling temperature.

If the liquid is multicomponent you must specify the initial composition. This is done by giving the 
initial concentration (volume fraction) for all the components but one: the missing concentration is 
then set automatically so that the sum of all the concentrations is 1. For example, Figure 7 shows the 
liquid folder being used to define the initial state for a spill of LNG, which is made up of methane 
and ethane. The initial concentration of methane has been entered as 0.92: the corresponding ethane 
concentration has been set to 0.08 by the interface.

4.2.3 Bubbles

You can choose to include the effects of bubbles in the simulation by checking the Model Bubbles
checkbox. The presence of bubbles in the liquid will increase the depth and therefore may have 
important implications for the spreading of the liquid on water or for possible overtopping of bund 
walls surrounding the spill.

Advanced Feature

It is possible to modify the calculation of the void fraction (bubbles) in LSMS. This facility is accessible by selecting the 
Advanced button, which displays the Advanced bubble parameters dialogue box (Figure 8):

Figure 8 The Advanced bubble parameters dialogue box

The values entered here are constants in the bubble model. Briefly, the value entered in the textbox “Lambda for 
bubbling (m/s)”modulates the rate at which bubbles escape through the upper surface of the pool, and the value entered in 
the textbox “Bubble source term constant” modifies the amount of vapour generated at the lower boundary of the pool. See 
Section 2.2.4 of the LSMS Final Report for more details.
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4.3 The Substrate folder

Figure 9 The Substrate folder

The Substrate folder allows you to specify the substrate on which the spill will take place. There are 
four main substrate types: (1) Homogeneous/Impermeable, (2) Homogeneous/Porous, (3) Two 
Layer and (4) Water. We will consider each in turn.

4.3.1 Homogeneous/impermeable substrates

This option represents a solid, impermeable, homogeneous substrate, which contributes heat to the 
spill by conduction. The temperature of the ground before the spill [Ground Temperature (K)] must be 
specified: this is also the temperature of the ground far from the surface at all times during the spill.

The thermal properties of the substrate, are coupled by the equation below:

thermal diffusivity = 
thermal conductivity

density x specific heat capacity

Consequently, you can only enter three of the four values and the fourth is then derived. (You can 
choose which value is calculated using the Options menu - see Section 6.1.1.) The values are entered 
using the textboxes Thermal Conductivity (kW/m/K), Thermal Diffusivity (m²/s), Density (kg/m³) and
Specific Heat Capacity (kJ/kg/K).
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Use the Slope textbox to enter the tangent of the angle that the ground makes with the horizontal. 
The slope is assumed to be uniform. Positive slopes indicate that the slope runs downhill from the 
source.

4.3.2 Homogeneous/porous substrates

This option represents a solid, porous, homogeneous substrate. The liquid can seep into the 
substrate, allowing heat transfer directly from the porous matrix to the seeped liquid; contributions 
from conventional conduction as well as convection are also included. The temperature of the 
ground before the spill [Ground Temperature (K)] must be specified: this is also the temperature of the 
ground far from the surface at all times during the spill. The thermal properties of the substrate are 
the properties for the entire porous medium in situ, i.e. without attempting to separate out the solid 
matrix from the pores or their contents, and they are specified in the Thermal Conductivity (kW/m/K), 
Thermal Diffusivity (m²/s), Specific Heat Capacity (kJ/kg/K) and Density (kg/m³) textboxes. The four values 
are coupled – see Section 4.3.1.

Use the Slope textbox to enter the tangent of the angle that the ground makes with the horizontal. 
The slope is assumed to be uniform. Positive slopes indicate that the slope runs downhill from the 
source.

You can use the Change Porous Properties button to view or edit the porous nature of the substrate. 
This displays the Porous Properties dialogue box, the basic version of which is shown in Figure 10. 
The advanced version gives the user access to some extra parameters (see below).

Figure 10 The Porous Properties dialogue box (basic version)

The absolute permeability and porosity (fraction of unit volume that consists of pores) control the 
rate of liquid seepage into the substrate. They are entered in the textboxes labelled 
Absolute Permeability (m²) and Porosity. Seepage can only occur until it reaches the depth given in the 
textbox Depth of Porous Layer (m). In typical situations the substrate below this depth is either 
saturated with water or is an impermeable layer. If the porous layer is effectively infinite, use the 
maximum depth (1000m).
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Advanced Feature

If the advanced features are switched on, some additional parameters are accessible from the Porous Properties dialogue 
box. This advanced version of the dialogue box is shown in Figure 11 below:

Figure 11 The Porous Properties dialogue box (advanced version)

Use the Grain Size (m) textbox to enter a representative diameter for a “grain” in the porous medium. It will be used to 
provide an estimate of the size of bubbles of vapour in the substrate. Use the Conductance (/s) textbox to specify the 
parameter used to characterise the heat flux from the porous medium into the liquid in the pores. Its value depends on 
properties of the porous medium, and needs to be found from experimental correlations, although a simple estimate 
assuming spherical grains and perfect thermal contact between the liquid and the matrix suggests that it could be of the 
order of 0.1 – 10 s-1. The default value of 1 s-1 is typical. The relative permeability scale (Rel. Permeability Scale in the 
dialogue box) is a scale factor used to determine the dependence of the volume fraction of liquid in the porous medium, 
and hence the relative permeability of liquid seeping into a porous medium, on the rate at which the liquid is being 
turned into vapour. Its value needs to be determined by experimental measurements of simultaneous seepage and boiling 
of a liquid (cryogen) in a porous medium. The default value of 0.25 is considered representative for a cryogen. Users are 
referred to the LSMS Final Report for more details on these parameters. 

(LiPSOL users should note that the relative permeability scale in LSMS is defined differently to the LiPSOL parameter 
with the same name.)

4.3.3 Two layer substrate

A two layer substrate is a solid substrate made up of two impermeable layers, which transfers heat 
into the spill by conduction. Typically the upper layer is insulating relative to the base layer. The 
temperature of the ground before the spill [Ground Temperature (K)] must be specified: this is also the 
temperature of the ground far from the surface at all times during the spill. The thermal properties of 
both layers of the substrate must be entered. The thermal properties [Thermal Conductivity (kW/m/K), 
Thermal Diffusivity (m²/s), Specific Heat Capacity (kJ/kg/K) and Density (kg/m³)] of the lower layer, i.e. the 
main bulk of the substrate, are set on the main Substrate folder itself. These  four parameters are 
coupled – see section 4.3.1. The properties of the upper layer can be set or viewed by clicking the 
Change Upper Layer button. This displays the Upper Layer Properties dialogue box (see Figure 12):
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Figure 12 The Upper Layer Properties dialogue box

The upper layer thickness is entered in the Layer Depth (m) textbox. The thermal properties of the 
upper layer are entered in the textboxes labelled Thermal Conductivity (kW/m/K), 
Thermal Diffusivity (m²/s), Specific Heat Capacity (kJ/kg/K) and Layer Density (kg/m³). These four 
parameters are again coupled – see Section 4.3.1.

Use the Slope textbox to enter the tangent of the angle that the ground makes with the horizontal. 
The slope is assumed to be uniform. Positive slopes indicate that the slope runs downhill from the 
source.

4.3.4 Spills on water

If a spill occurs on water, heat is transferred to the liquid from the water below at a fairly constant 
rate due to convection set up in the water. If ice formation is not modelled then the heat flux is taken 
to be constant throughout the simulation at the value entered in the Initial Heat Flux (kW/m²) textbox. 
To model ice formation during the spill check Ice Formation. In this case the heat flux from the water 
to the liquid will start at the value entered in the Initial Heat Flux (kW/m²) textbox and decay 
exponentially to the value shown in the Final Heat Flux (kW/m²) textbox.
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4.4 The Atmospheric folder

Figure 13 The Atmospheric folder

The Atmospheric folder contains the data determining the effects of the atmosphere on the spill. The 
main parameters are the solar heat flux [Solar Flux (kW/m²)], the roughness height and the friction 
velocity. The solar flux is the net solar heat flux absorbed by the pool, i.e. after the processes of 
reflection, absorption, etc. have already taken place. The roughness height and friction velocity are 
used in the evaporation model, and should be representative of the flow over the pool. There are 
several methods available for specifying these two parameters. Whichever method is used the values
are displayed or entered in the textboxes Roughness Height (m) and Friction Velocity (m/s).

There are three methods of specifying the roughness height, determined by the radio buttons above 
the Roughness Height (m) text box (see Figure 13).

 Select Smooth to use a roughness height for aerodynamically smooth flow over the pool (wind 
tunnels).

 Select Rough to use a roughness height for aerodynamically rough flow over the pool (practical 
situations). A fixed value of 2.28x10-4m is used, as proposed by Brighton (1985)5.

 Select Custom to specify an explicit roughness height value yourself.
                                                
5 Brighton, P.W.M. 1985 Evaporation from a plane liquid surface into a turbulent boundary layer. J. Fluid Mech. 159, 
323-345.
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You can choose to specify the friction velocity directly, or to give a measured wind speed. To give a 
measured speed, check the Use reference speed and height check box. You should then supply a 
measured wind speed and the height at which the measurement was made (using the 
Wind Speed (m/s) and Wind Height (m) textboxes respectively). The friction velocity will be calculated 
from these values.

4.5 The Bund folder

Figure 14 The Bund folder

The Bund folder controls the specification of any bund present. There are three Sections: (1) Bund 
Treatment, (2) Bund Dimensions and (3) Bund Wall Thermodynamic Properties.

4.5.1 Bund treatment

The most important decision on this folder is whether or not to include a bund in the simulation. To 
include a bund, check the Bund present checkbox. If this is not checked the other controls on the 
folder will be disabled.

You can also choose whether to model the evolution of any liquid which overtops the bund wall. 
The simulation will proceed faster if you do not model the overtopped fluid; if necessary, you can 
model the evolution of the overtopped fluid later by creating a secondary source (see Section 
4.1.1(c)). However, it should be noted that the overtopped fluid will be modelled more accurately if 
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it is included in the primary spill. To include the overtopped fluid in the primary spill check the 
Model overflow checkbox.

4.5.2 Bund dimensions

This section allows you to specify the dimensions of the bund. The geometry of the bund is assumed 
to be the same as the geometry of the spill specified on the Configuration folder (see Section 4.1.2). 
Use the Bund Radius (m) textbox to enter the distance from the origin to the inside of the bund wall 
(the inner radius of the bund). Notice that when the ground is sloping this is the distance to the bund 
wall along the ground. Use the Bund Depth (m) textbox to enter the height of the bund wall, assumed 
perpendicular to the ground, and the Bund Thickness (m) textbox to enter the thickness of the bund 
wall (i.e. the outer radius minus the inner radius).

4.5.3 Bund wall thermal properties

This section specifies the thermal properties of the bund wall material, namely thermal conductivity, 
thermal diffusivity, specific heat capacity and density. These four parameters are coupled – see 
Section 4.3.1. 

4.6 The Numerical folder

The Numerical folder (see Figure 15) describes aspects of the numerical solution of the governing 
equations, and also contains the run title. It contains three sections: (1) Output, (2) Numerical 
Parameters and (3) Time Resolution.

4.6.1 Output

This section contains a string describing the simulation [Run Title]. It is used as the default title for 
any printed graphs. It is an opportunity for the user to make some remarks about what is of 
particular importance or interest for the problem being set up, e.g. a particular choice of one or more 
parameters, a change in a parameter to examine its effect relative to an earlier run, and so on.
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Figure 15 The Numerical folder

4.6.2 Numerical parameters

The default numerical parameters should not need to be changed in normal circumstances. The 
Maximum No. Of Timesteps textbox is used to prevent the execution time of a simulation from being 
excessively large. If the simulation has taken more timesteps than this number without reaching the 
end of the specified duration, it is terminated. The default value is 2,000,000. If you should find that 
a particularly long simulation is failing to reach the end time, and the log file contains a message 
like the one in Figure 16, you should increase this value.

===================================

LSMS: Liquid Spill Modelling System

Double Precision 32-bit Edition

Version 1.00 (c) CERC 1997

===================================

  

Running file C:\TEMP\TEST-02.LPL

  

         t   xFront        dt   step     n   real t

      .000    6.600  .192E+00       0    0       .8

    ….

   1000.192   6.797  .192E-02  2000001  250    89.7

Program terminated because of large number of timesteps:    2000001 taken: limit is   2000000

Run completed in      89.72 seconds real time.

Figure 16 A log file for a simulation which took too many timesteps

Most of the log file has been omitted

Notice the error message
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4.6.3 Time resolution

The timestep used by LSMS is optimised so that the simulation can execute as quickly as possible, 
while still producing accurate results. Hence under normal circumstances there is no need to adjust 
the timestep. However, if a particular case seems to be simulated with too large a timestep, the user 
can exercise some control over the timestep size used during the simulation by means of the 
Time Resolution feature. This control consists of a slider which is moved along a scale: the left-hand 
end of the scale corresponds to coarse resolution, with a nominal value of 0.5, while the right-hand 
end corresponds to fine resolution, with a value of 6. In the majority of cases, the default resolution 
of 1 is sufficient to produce accurate results. Note that with an increase in resolution there is an 
increase in execution time, since the timestep is reduced by a factor of n, the time resolution value –
hence the reason for the labels “fast simulation” and “slow simulation” at the two ends of the scale. 
The execution time for the simulation will therefore increase by a factor of approximately n.

Advanced Feature

You can select the Fine Control button to control the timestep more precisely than is possible with the Time Resolution
control (see 4.6.3). This button will launch the Advanced Numerical Parameters dialogue box (Figure 17).

Figure 17 The Advanced Numerical Parameters dialogue box

If you check the Modify timestep during run? checkbox, you can enter a factor in the Timestep Multiplier textbox. All 
timesteps after that given in the Use After Step textbox will be reduced according to the specified factor. This will, of 
course, increase the execution time for the simulation.

This facility is useful if you have a long problem case and the timestep appears to be too large at a late stage in the 
simulation, since it allows you to use a smaller timestep only in the later stages of the simulation. Using the Time 
Resolution control modifies the timestep from the very start of the simulation, and might increase the execution time 
unacceptably. 

A typical usage of this feature might proceed as follows. First of all you decide when the simulation seems to begin 
using too large a timestep, then look in the log file to find out the approximate timestep which corresponds to the onset 
of these difficulties. Now open the Advanced Numerical Parameters dialogue box and check the Modify timestep during run?
checkbox. Enter the timestep number in the Use After Step textbox. Enter a value in the Timestep Multiplier textbox of less 
than 1 and press OK. Save the LPL file under a new name and run the simulation.
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Advanced Feature

You can select the Hydrodynamics button to access some of the parameters controlling the simulation of hydrodynamic 
aspects of the spill. It is recommended that the default values for these parameters should be used for most simulations, 
and that the LSMS Final Report should be consulted before they are changed. The button launches the 
Hydrodynamics parameters dialogue box (Figure 18).

Figure 18 The Hydrodynamics parameters dialogue box

The Front Treatment radio buttons allow you to specify the treatment of the front in the hydrodynamics calculations. If 
Constant Froude Number is chosen, the front has a constant Froude number throughout the simulation. The Froude number
value is entered in the Basic Froude textbox. If Surface Tension is chosen, then surface tension effects are modelled in a 
simple way by defining a minimum height in the Surface Tension Height (m) textbox. As the pool depth at the front 
approaches this value, the Froude number is made to decrease to zero, so that the front stops if the pool is shallow 
enough.

Comparisons with data suggest that the Froude number should be kept at around 1.2–1.4. The surface tension height 
would be expected to vary with roughness: 0.003 m is appropriate for average roughness.

The value in the Turbulent Drag textbox controls turbulent drag on the pool as a whole, and we model this force as a 
quadratic velocity term. The default values are 0.01 for a solid substrates,  and 0.003 for spills on water. It should be 
noted that LSMS is more sensitive to this parameter than to any other advanced parameter. The value could be varied to 
reflect the roughness of the substrate, but only with caution.

The value entered in the Dry-Out Depth (m) textbox is the depth at which we deem the pool to have vanished at a given 
point. This avoids using excessively small pool depths in the calculations, when the fluid depth is, in effect, negligible 
but which might otherwise lead to problems for the calculation. This value should be small, but not smaller than the 
default value (10-6m).

Check the Include viscous shear stress checkbox to include the effects of viscosity in the simulation. The liquid viscosity 
is calculated from information in the liquid database.



Section 4: The LSMS input data

- 28 -

Advanced Feature

The mesh size used by LSMS is optimised so that the simulation can execute as quickly as possible, while still 
producing accurate results. Hence under normal circumstances there is no need to adjust the mesh size. However, if a 
particular case seems to be simulated with too large a grid, the user can exercise some control over the mesh size used 
during the simulation as follows.

Figure 19 The Spatial Resolution dialogue box

Select the Spatial Resolution button from the Numerical folder. This launches the Spatial Resolution dialogue box (see Figure 
19).

This dialogue box operates similarly to the Time Resolution control explained above. There is a slider which is moved 
along a scale: the left-hand end of the scale corresponds to the default resolution, with a nominal value of 1, while the 
right-hand end corresponds to fine resolution, with a value of 10. In the majority of cases, the default resolution is 
sufficient to produce accurate results. Note that with an increase in resolution there is an increase in execution time.
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5 Plotting the results

5.1 Plotting overview

Figure 20 The Plot folder

Having successfully completed a simulation, the user will want to examine the output produced, and 
display the results graphically. The Plot folder allows the user to do this. There are four types of 
graph which can be produced: time series, snapshots, totals and averages.

 Time series are plots of the time evolution of a quantity at a particular location.

 Snapshots are plots of the spatial distribution of a quantity at a particular time.

 Totals are graphs of the time evolution of properties summed over the whole pool.

 Averages are plots of the time evolution of properties averaged over the whole pool.

Time series can be produced for a set of positions, and snapshots can be produced for a set of times. 
In LSMS, each individual graph in a set like this is called a frame. 

In addition to producing graphs, the user can interrogate the data file and display the numerical 
values of the properties of the pool at a particular time and place (see Section 6.4).
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5.2 Selecting data to plot

Figure 21 The dialogue box for selecting data to plot

To produce a set of graphs, select the Select Data button on the Plot folder (Figure 20). This will 
display the Select Data dialogue box (Figure 21). This dialogue box is used to specify the graphs 
which are to be produced, as explained below.

 First, use the Display Type listbox at the top left to choose the type of graph to generate: either 
time series, snapshots, totals or averages.

 Next choose the variables which are to be plotted by selecting the relevant checkboxes in the 
Variables section of the dialogue box. For time series and snapshots the Units for some variables 
can be altered. If you choose Use length-based units you can plot pool height in m, the velocity in 
m/s and the vaporisation rate in mm/s. If you choose Use mass-based units these variables are 
converted into mass-based equivalents, i.e. you can plot the mass per unit area in kg/m², the 
mass flow rate in kg/s and the vaporisation rate in kg/m²/s. Note that plots of total mass do not 
include liquid which has seeped into a porous substrate.

 You can modify the range of the x-axis for your graph either before or after the graphs are 
produced. To do so before the graphs are produced, select the Range button. This displays a 
dialogue box which allows you to set the minimum and maximum values for the x-axis. (See 
Section 5.4 for details of how to modify the axes after the graphs have been produced.)

 If you have chosen to produce time series or snapshots, you must select one or more frames (for 
snapshots you must give the times for which graphs are to be produced and for time series you 
must give the positions for which graphs are to be produced). There are two methods of 
specifying the frames. Use the Selection Method radio buttons to select one: choose either 
Equi-spaced (to produce a set of equally spaced times or positions) or Custom (to choose specific 
times or positions to use). Then choose the Select button to specify the frames, as described in 
the rest of this section.
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5.2.1 Selecting equally spaced frames

Figure 22 Dialogue box for selecting equally spaced frames

If you are producing equally spaced frames for time series, the Select button will display the 
dialogue box in Figure 22. Time series will be generated for a series of positions from the minimum 
[Minimum position (m)] to the maximum [Maximum position (m)] separated by the interval which you 
enter [Interval (m)].

If you are producing equally spaced frames for snapshots, the Select button will display a dialogue 
box similar to that shown in Figure 22. Snapshots will be generated for a series of times from the 
minimum [Minimum time (s)] to the maximum [Maximum time (s)] separated by the interval which you 
enter [Interval (s)].

5.2.2 Selecting custom frames

Figure 23 Dialogue box for selecting custom frames

If you are producing custom frames for time-series, the Select button will display the dialogue box 
shown in Figure 23. Time series will be generated for each position in the list of Current values. You 
can add new positions to the list by entering a value in the Next position (m) textbox, then pressing the 
SPACEBAR. Positions greater than zero are interpreted as distances from the origin: positions less than 
or equal to zero are interpreted as distances behind the front: for example, -1 represents a position 
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1m behind the front, and 0 represents the front itself. The list will be sorted into ascending order as 
you add items to it. Unwanted values can be removed from the list by double-clicking them with the 
left mouse button.

If you are producing custom frames for snapshots, the Select button will display a dialogue box 
similar to that shown in Figure 23. Snapshots will be generated for each time in the listbox 
Current values. You can add new times to the list by entering a value in the Next time (s) textbox then 
pressing the SPACEBAR. Unwanted values can be removed from the list by double-clicking them with 
the left mouse button.

5.2.3 Variables which can be plotted

This section defines the output variables from a run of LSMS which can be plotted.

5.2.3.1 Variables which are available for time series and snapshots

These variables are available both for snapshots and time series. They all represent local values at a 
specific position in the pool and a specific time. Note that variables marked with a common 
superscript are alternative versions of the same variable – the Units radio button on the Plot folder 
may be used to toggle between length-based and mass-based units.

Interface height (m)a The depth of the pool. For spills on water, the position of the upper and the 
lower interfaces will be plotted on the same set of axes relative to “mean 
sea level”. For spills on porous substrates, the seepage depth and the depth 
of the pool above ground will be plotted on the same set of axes.

Mass per unit area 
(kg/m²)a

The local mass per unit area. For spills on porous substrates, this does not
include any seeped liquid but applies only to liquid above ground.

Velocity (m/s)b The velocity of the liquid in the pool.

Mass flow rate (kg/s)b The mass flow rate of the liquid in the pool.

<Component> 
concentration

The concentration (volume fraction) of <component>. For spills on porous 
substrates, this refers only to the liquid above ground.

<Component> vapour 
concentration

The concentration ) of <component> in the vapour (as a volume fraction, or 
equivalently a mole fraction, since we treat the vapour as an ideal gas).

Temperature (K) The temperature of the liquid. For spills on porous substrates, this refers 
only to the liquid above ground.

Vaporisation rate 
(mm/s)c

The rate at which liquid is being converted into vapour (surface regression 
rate).

Vaporisation rate 
(kg/s/m²)c

The rate at which liquid is being converted into vapour, in mass-based
units.

Position (m) The position for which values are being plotted (time series plots only). 
This is useful only when a position has been given relative to the front, and 
therefore varies with time.

Void fraction The fraction of the pool depth which is occupied by bubbles. For spills on 
porous substrates, this refers only to the liquid above ground.



Section 5: Plotting the results

- 33 -

5.2.3.2 Variables for totals

These variables are total quantities summed over the entire pool. They are plotted as functions of 
time.

Total mass of liquid 
(kg)

The total mass of liquid in the pool. For spills on porous substrates, this 
does not include the seeped liquid but refers only to liquid above ground.

Total vaporisation 
rate (kg/s)

The rate at which liquid is being converted into vapour for the whole pool.

Mass which has 
escaped bund (kg)

The total mass which has overtopped the bund up to the present time. This 
is intended as an indicator of the magnitude of the overtopping, and is not
the same as the total mass of liquid in the secondary region, since no
allowance is made for subsequent vaporisation in calculating this quantity.

Total mass of 
<component> (kg)

The total mass of <component> in the pool. For spills on porous substrates, 
this does not include the seeped liquid but refers only to liquid above
ground.

5.2.3.3 Variables for averages

These variables are average quantities for the entire pool, i.e. totals averaged over the area of the 
pool. They are plotted as a function of time.

Average mass of 
liquid (kg/m²)

The average mass of liquid per unit area in the pool. For spills on porous 
substrates, this does not include the seeped liquid but refers only to liquid 
above ground.

Average vaporisation 
rate (kg/s/m²)

The average vaporisation rate per unit area for the pool.

<Component> mass 
fraction

The average concentration of <component> in the pool as a mass fraction. 
For spills on porous substrates, this does not include the seeped liquid but 
refers only to liquid above ground. 
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5.3 Viewing graphs

Figure 24 The Plot folder (with graphs)

When you have used the Select Data dialogue box to produce a set of graphs, you can then view 
them on the Plot folder. There are a number of controls at the top of the folder which affect your 
view of the graphs you have produced.

 The Display Type listbox (at the top left) allows you to swap between the display types for which 
you have produced graphs (time series, snapshots, totals or averages).

 The Variables listbox to the right of the Display Type listbox allows you to choose the variable 
which is to be displayed. Alternatively, you can use the spin buttons next to it to move through 
the list of variables.

 For time series and snapshots you can use the Frame section (at the top right) to control which 
frames are displayed. The listbox has a list of the positions or times which were generated, and 
you can use it to swap between them. Alternatively, you can use the spin buttons next to it to 
move through the list of frames. Multiple sets of frames can be displayed on one pair of axes by 
checking the Multiple Frames checkbox. The number of frames which will be displayed at one 
time is set in the No. Frames text box.

Note that if an item from a list box is selected (as for example Interface height is selected in Figure 
24), then the  CURSOR and  CURSOR keys can be used to move backwards and forwards through 
the list. In the case of the Frame list, selecting the first frame in this way, and keeping the key 
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depressed, in effect animates the display, which can be instructive in demonstrating the evolution of 
the pool shape when the frames are equally-spaced snapshots.

5.4 Customising graphs

There are two buttons on the Plot folder which allow you to customise the appearance of your 
graphs: the Graph Style button and the Graph Axes button. Both display dialogue boxes, which are 
discussed below.

5.4.1 Using the Graph Style dialogue box

Select the Graph Style button on the Plot folder to access the Graph Style dialogue box, which gives 
control over the appearance of the graphs. The dialogue box is divided into folders. Some of the 
most useful aspects are explained below, folder by folder.

 The Style folder allows you to apply a logarithmic scale to the x-axis, the y-axis, or both.

 The Data folder allows you to view the values for the first 100 points of the graph.

 The Axis folder allows you to choose whether to have a grid in the background of the graph (by 
checking Show in the Grid section). Users should not attempt to alter the range of the axes here; 
they should use the Graph Axes dialogue box instead (see Section 5.4.2 below).

 The Fonts folder allows the user to alter the fonts which are used for the text elements of a 
graph.

 The Markers folder allows the user to alter the line style and markers used to display the data.

 The Background folder allows borders and backgrounds of various styles to be added to the 
elements of the graph.

There is extensive on-line help for this dialogue box, to which users are referred if they wish to 
experiment with it in more detail.
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5.4.2 Using the Graph Axes dialogue box

Figure 25 The Graph Axes dialogue box

Select the Graph Axes button on the Plot folder to reach the Graph Axes dialogue box, which controls 
the ranges of the axes. This dialogue box is shown in Figure 25, for a snapshot of total height 
against position. It allows you to set the maximum and minimum values for each axis, and the 
number of subdivisions (ticks) between zero and the maximum value. Users should bear in mind 
that all the graphs in a particular display type will then have the same x-axis: a change made to one 
graph will affect all the others.

5.5 Printing graphs

Once you have produced a set of graphs, you can print them to any printer supported by Windows. 
To print the current set of graphs select the Print Graphs button on the Plot folder or choose the 
Print Graphs option from the File menu. This displays the Print Graphs dialogue box (Figure 26). 

Note: all the graphs which are being viewed on the Plot folder are printed as a set: i.e. all the display 
types, variables and frames will be printed together. Before printing graphs, users should check 
which graphs are included in the current set by means of the list boxes at the top of the Plot folder, 
otherwise they may produce unwanted printed output.
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Figure 26 The Print Graphs dialogue box

The Print Graphs dialogue box allows you to specify how the graphs will appear on the printed page.

 The number of graphs (i.e. sets of axes) which will be printed per page is set by the 
No. of graphs on a page listbox at the top left of the dialogue box.

 The text entered in the Page Title textbox will appear at the head of each page of graphs. The 
default title is the run title of the simulation. The font size for the page title is set in the text box 
Font Size (Point).

 The Printer Type radio buttons should be set to either Colour or Black and White depending on the 
printer to be used.

 The printer can be changed or its settings altered by selecting the Printers button.

 Check Add border round each graph to apply a box border to each graph.

 Check Use white background for graphs to give each graph a white background.

 Check Show print details in footer to include details of the filename and date of the printout at the 
foot of each page.

 Check Show title on each graph to include a title with each graph. This is not the same as the page 
title.

 The Current Graphs section lists the graphs which have been generated. The number of variables 
and frames in each display type are shown. This reminds the user how many graphs are being 
printed.
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5.6 Saving and loading graphs

Once a set of graphs has been produced, it can be saved for later retrieval. This facility may be 
useful for graphs which may be needed later, for instance if they appear in a report.

To save a set of graphs, select the Save Graphs button on the Plot folder. You will be asked to give 
the set a descriptive name so that you can identify it later.

To retrieve a saved set of graphs, select the Load Graphs button. A list of the graph sets saved for the 
current LPL file will be displayed, with the name for each and the date and time on which each was 
saved. To load a set, select it in the list box and press the OK button.

5.7 Copying graphs

As an alternative to printing graphs, it is possible to copy individual graphs to the Windows 
clipboard for pasting into a Windows word-processing or drawing package. To copy the current 
graph, choose Copy Graph from the File menu. You will then be able to paste the graph into another 
Windows application.

5.8 Clearing graphs

To discard all the graphs which have been created, select the Clear Graphs button on the Plot folder. 
You can then specify a new set of graphs using the Select Data dialogue box (see Section 5.2), or 
reload a saved set (see Section 5.6).

5.9 Exporting graph data to a spreadsheet

An alternative to printing a graph is to save the graph data to a text file so it can be imported into a 
spreadsheet such as Microsoft Excel. The text file generated consists of columns of data separated 
by tab characters. This format is widely accepted by spreadsheet packages.

To save the data from the graph you are currently viewing, choose the Save Data button from the Plot
folder. You will be asked to give a filename for the text file. The data for the current graph will be 
saved into this file.

To load this file into Microsoft Excel (version 5.0) choose the Open command from the File menu 
and select the file you have just created. Excel will start the file import Wizard, where you can 
specify how the file is to be interpreted. Excel should be able to detect the file type and fill in the 
Wizard appropriately, but it is worth checking these settings to make sure this process has 
succeeded. On the first screen, make sure that the Original Data Type is “Delimited”. Move to the 
second screen and make sure that only the checkbox marked Tab is checked in the Delimiters section. 
On the third screen, simply click Finish. The graph data should appear in a new worksheet.
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6 Further features

6.1 Options

It is possible to customise the behaviour of the LSMS interface and 
simulation engine by using the commands available on the Options
menu (pictured at left). The individual options are explained in detail 
in the sections below.

Those options which are either on or off, such as 
Show Advanced Options, have a tick to the left of the option name if 
they are turned on. To switch the state of these options between on 
and off, select the menu option in the usual way.

6.1.1 Thermal diffusivity options

In several sections of the interface LSMS requires the specification of the thermal properties of a 
material: specifically thermal conductivity k, density , specific heat capacity Cp and thermal 
diffusivity . These properties are linked by the relation  = k / ( Cp). Consequently, only three of 
the properties need to be entered and the fourth is calculated. You can control which value is 
calculated by selecting Thermal Diffusivity from the Options menu. This displays the Options for entering 
linked thermal properties dialogue box (see Figure 27). Simply select the value which you want to be 
calculated from the Chosen method radio buttons.

Figure 27 The dialogue box for controlling the linked thermal properties

6.1.2 Including problem summaries with printouts

To include a printed summary of the problem input data automatically with each printed set of 
graphs, check Print Summary With Graphs on the Options menu.
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6.1.3 Prompting for run titles at each save

The Run Title on the Numerical folder provides an opportunity for the user to make some remarks 
about what is of particular importance or interest for the problem being set up, e.g. a particular 
choice of one or more parameters, a change in a parameter to examine its effect relative to an earlier 
run, and so on. It is recommended that this facility is used to help distinguish LPL files from one 
another. If you check Prompt For Title At Save on the Options menu, you will be asked to confirm the 
Run Title each time you save an LPL file. This allows you to make sure the title is appropriate to the 
input data set.

6.1.4 Automatic notification when simulations terminate

The LSMS interface can notify the user when a single simulation finishes by displaying a dialogue 
box. To enable this feature, check Notify After Run on the Options menu.

The interface can also notify the user when a list of problems finishes by displaying a dialogue box. 
To enable this feature, check Notify After List on the Options menu. If Notify After Run is checked, the 
user will be notified after each simulation in the list has finished. (See Section 6.3 for details of how 
to set up and execute lists of problems.)

6.1.5 Choosing the 16-bit or 32-bit version

LSMS can run either under Windows 3.1 (a 16-bit operating system) or Windows 95 or NT (32-bit 
operating systems). The operating system is set when LSMS is installed. It can be changed 
subsequently by checking either Use 16 bit model or Use 32 bit model on the Options menu.

It is recommended that this option should not be changed once LSMS has been installed 
successfully.

6.1.6 The advanced features of the interface

The LSMS interface has been divided into basic and advanced features. It is recommended that the 
advanced features are avoided in normal use of LSMS, since these features require a more detailed 
understanding of the model. In general the user is advised to consult the LSMS Final Report before 
making use of any advanced feature.

The advanced features can be hidden from view, to prevent accidental misuse. To hide the advanced 
features, uncheck Show Advanced Options on the Options menu.

6.1.7 Simulation run time graphics

The Windows 95 / Windows NT version of LSMS has the facility to graph the progress of the 
simulation as the run proceeds. Users should bear in mind that this option can result in a quite 
significant reduction in the speed of the run, depending on the graphics capabilities of the computer 
used. To turn the graphics on check Run Time Graphics on the Options menu. The options on the 
Graphics menu of the simulation window can then be used to control the graphics as the simulation 
proceeds.
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6.2 Linking to dispersion models

The results of an LSMS spill simulation can be exported to a dense gas dispersion model, so that the 
dispersion of any evolved vapour can be modelled. There are three ways in which the results of a 
simulation may be exported from LSMS.

 LSMS output can be exported to version 3.00 or later of GASTAR (a model developed by 
CERC), provided both models are installed on the same computer.

 LSMS can create input files for HAGAR (a model developed by BG).

 To enable users to interface with other dispersion codes, LSMS can create text files containing 
the relevant details of the spill in a generic format. These files can then be used to create any 
input format required by the dispersion model.

In exporting the results of an LSMS simulation it is assumed in all three cases that the dispersion 
codes treat a time-dependent source by modelling the time-variation as a sequence of constant-
inflow sources. It is therefore necessary to partition the output from the LSMS run into a series of 
segments for the dispersion simulation. Hence the user is asked to choose how this partitioning is to 
be carried out by means of a dialogue box (see Figure 29).

6.2.1 Linking to GASTAR

To export LSMS output to GASTAR, first of all open an LPL file for which a simulation has 
already been carried out. Now choose Send Info To GASTAR from the Dispersion menu. The first time 
you use this option, you will be asked to find an installed copy of GASTAR. Use the dialogue box 
(Figure 28) to find the file Gaswin.exe, which is the main program file for GASTAR.

Figure 28 Dialogue box for locating GASTAR installation

The GASTAR interface will then be launched. Next you will be asked if you want to use the pool 
uptake model in GASTAR. This module of GASTAR models the formation of a vapour cloud 
above the liquid pool, and produces a time-varying source for the main GASTAR model. Users are 
referred to the GASTAR documentation for more details.
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The dialogue box shown in Figure 29 will then be displayed, so that the LSMS run can be 
partitioned into segments for the GASTAR simulation (see above). The duration of the LSMS run is 
shown at the left of the dialogue box. The user enters the start and end times and the number of 
segments into which the LSMS results are divided for interpretation by GASTAR using the text 
boxes Start time (s), Stop time (s) and Segments.

Figure 29 Dispersion time domain dialogue box

On selecting OK, the LSMS interface will then calculate average values of the vaporisation, pool 
size, etc. for use in each segment of the GASTAR simulation. Finally, the GASTAR interface will 
be loaded with the data generated from the LSMS results, and displayed so that the input data for 
the GASTAR run can be completed. If you have chosen to use the pool uptake model, the interface 
will be open at the appropriate dialogue box.

6.2.2 Creating HAGAR files

LSMS has the facility to create a set of input files for HAGAR from the results of a simulation. To 
produce HAGAR files, choose Make HAGAR Files from the Dispersion menu. The dialogue box in 
Figure 29 will be displayed. Specify the partitioning of the LSMS run into segments as explained in 
Section 6.2.1. 

When you select the OK button on the dispersion time domain dialogue box, another dialogue box 
appears asking you to complete the rest of the input data for a HAGAR file (Figure 30). Some of the 
entries will have been filled in with data derived from the LSMS data. The rest should be filled in 
by the user. Users are referred to the HAGAR documentation for definitions of the data items used 
by HAGAR.
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Figure 30 HAGAR parameters dialogue box

6.2.3 Creating files for a generic dispersion model

LSMS can also create text files containing details of the vaporisation during the simulation. These 
files are designed to be easily converted to alternative file formats.

To produce a file of this kind, choose Make Generic File from the Dispersion menu. The dialogue box 
shown in Figure 29 will appear. Specify the partitioning of the LSMS run into segments as 
explained in Section 6.2.1. A file will be created with the same filestem as the LPL file, but with the 
extension .TXT.

The data in the file is in columns, separated by tab characters (see Figure 31). It consists of average 
values at various times for the vaporisation rate (kg/s), the width of the pool (m), the temperature of 
the vapour (K), its density (kg/m³) and the concentrations (mass fractions) of the components of the 
vapour.
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Time(s) Vap rate (kg/s) Width (m) Temp (K) Density (kg/m³) Conc Methane 

2 54.85321 24.54736 111.8662 1.77769 1.000 

6 120.3766 30.98344 111.8198 1.863088 1.000 

10 177.4817 37.21472 111.791 1.794889 1.000 

14 217.3003 42.53863 111.7713 1.782505 1.000 

18 253.4168 47.27015 111.7592 1.772454 1.000 

22 282.0639 51.5599 111.7496 1.768677 1.000 

26 307.3297 55.51102 111.742 1.766356 1.000

30 331.0158 59.09095 111.7363 1.759716 1.000

34 350.5164 62.44209 111.7313 1.760468 1.000

38 369.468 65.59709 111.7272 1.759956 1.000

42 387.6699 68.57581 111.7239 1.757404 1.000

46 404.2445 71.42577 111.7209 1.757914 1.000

50 421.84 74.13533 111.7186 1.756503 1.000

54 436.6907 76.74989 111.7162 1.755139 1.000

58 451.6053 79.28918 111.7142 1.756896 1.000

62 467.1133 81.72985 111.7125 1.756552 1.000

66 481.2026 84.07809 111.7108 1.755604 1.000

70 495.3314 86.3613 111.7094 1.755134 1.000

74 508.5619 88.57378 111.708 1.75494 1.000

78 521.1422 90.74412 111.7067 1.754216 1.000

82 533.8445 92.85405 111.7056 1.754455 1.000

86 546.1724 94.90705 111.7045 1.75428 1.000

90 557.8319 96.90535 111.7034 1.754338 1.000

94 569.1727 98.86556 111.7025 1.753974 1.000

98 579.8741 100.7949 111.7015 1.75395 1.000

Figure 31 An example generic dispersion file

6.3 Running lists of problems

LSMS has the facility to run sets of problems consecutively, which is useful if the user has a set of 
lengthy problems and wishes to run them all as one operation. Before using this facility you must 
create a list of problems. The lists are stored in files, which usually have the extension LST.
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6.3.1 Creating a list of problems

Select Edit List from the File menu. This will display the dialogue box for creating and editing lists of 
problems (Figure 32).

Figure 32 Dialogue box for creating and editing lists of problems

 The Current list section at the centre of the dialogue box shows the files in the current list.

 To add a new file to the list, first find it using the controls at the left side: the list box at the top 
left allows you to change to another drive, and the listbox at the centre left allows you to find the 
correct directory. Then highlight the file in the listbox at the bottom left and select the Add To 
List button or double-click the file with the mouse

 Files can be removed from the Current list by double-clicking them with the mouse.

 Use the Clear List button to remove all files from the current list and begin again from scratch.

 You can open an existing list file by selecting the Open List File button and selecting the file in 
the resulting dialogue box.

 You must save a list to a file before you can use it to carry out a batch of simulations. To do this 
select the Save List File As button. You will then be prompted to provide a file name.

6.3.2 Running a list of problems

Once you have created and saved a list of problems, they can be executed by using the List command
from the Run menu. You will be asked to choose a list file, then the LPL files listed in it will be 
executed in sequence.
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6.4 Inquire facility

LSMS allows the user to obtain the numerical values of the pool properties at a specified time and 
position during the simulation. This is done by selecting the Inquire button from the Plot folder, 
which displays the Examine Output dialogue box (Figure 33).

Figure 33 The Examine Output dialogue box

To obtain the properties of the pool at a given place and time, enter the position (distance from the 
origin) and the time of interest in the textboxes Position (m) and Time (s), then select the Update
button. Your specified time will be replaced with the nearest time for which output was stored. The 
left side of the dialogue box will be filled with the properties of the pool at the position and time 
specified, and the right side with total and average properties for the whole pool at that time.

The interpretation of the output may need a little clarification. The Pool Depth (m) textbox shows 
the total depth of the pool. The Velocity (m) textbox displays the velocity of the liquid away from the 
source. The Concentration textbox shows the volume fraction of the first component in the liquid at 
the position and time given. The Temperature (K) textbox shows the temperature of the fluid (above 
ground level). The Vaporisation Rate (mm/s) textbox shows the rate at which vapour is escaping from 
the pool at the specified point, in terms of the depth of liquid being lost per second. For spills on 
water the depth of the lower interface below “sea level” is shown in the textbox 
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Depth Below Water (m). For spills on a porous substrate the seepage depth is shown in the textbox 
Saturation Depth (m).

The Total Mass (kg) textbox shows the total mass of liquid. For spills on a porous substrate, this does 
not include liquid which has seeped into the substrate. The Mass of Component (kg) textbox shows 
the total mass of the first component in the liquid. For spills on a porous substrate, this does not 
include liquid which has seeped into the substrate. The Total Vaporisation (kg/s) textbox shows the 
total mass of vapour which is escaping from the pool per second. The Average Concentration textbox 
shows the mass fraction of the first component in the entire pool. The Average Mass (kg/m²) textbox 
shows the average mass of liquid per square metre in the pool. For spills on a porous substrate, this 
does not include liquid which has seeped into the substrate. The Front Position (m) textbox shows the 
position of the liquid above ground and furthermost from the source. The Area (m²) and Volume (m³)
textboxes show respectively the surface area and volume of the entire pool at the time given.

6.5 Liquid database editor

LSMS is distributed with a database of predefined liquids, which can be edited using the tool 
LIQEDIT.EXE. This has been implemented as a separate program since it will probably be used 
infrequently,  and this also allows administrators in a multi-user environment to control access to 
the database. To prevent less experienced users from altering the database, simply remove 
LIQEDIT.EXE from their LSMS installation. Note that the files containing the liquid properties are 
automatically stored in the data subdirectory of the LSMS home directory.

Figure 34 LSMS liquid database editor 
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6.5.1 The Liquid menu

The Liquid menu allows new liquids to be created and existing liquids to be modified or deleted.

 To create a liquid from scratch, choose New.

 To open an existing liquid, choose Open and choose the liquid from the list 
displayed.

 To delete an existing liquid, choose Delete and choose the liquid from the list 
displayed.

 To save the current liquid, choose Save. (The liquid name is specified as one 
of its properties.)

 Export allows the liquid database to be saved to a text file in tab-delimited 
form. It can then be loaded into a spreadsheet.

 Exit closes the liquid database tool.

6.5.2 Entering a liquid’s properties

Figure 34 shows the liquid database editor with a predefined liquid loaded. This liquid is “LNG”, 
taken to be a mixture of methane and ethane. Note that the composition is not set in the database, 
but is set for each LPL file, using the Liquid folder (see Section 4.2).

At the top of the screen is the Name text box, where the name of the liquid should be entered. Next 
to this is a label indicating when the liquid was last modified.

The properties of the individual components are displayed on tabbed folders like those for the main 
LSMS interface. These properties apply to the liquid phase except for the molecular diffusivity of 
the vapour [Molecular Diffusivity (m²/s)]. In general if any properties vary with temperature values for 
some typical spill temperature should be used: i.e. the lower of the boiling point of the liquid and a 
“typical” ambient temperature, e.g. STP.

You should enter the density and boiling point of the liquid [Liquid Density (kg/m³) and Boiling Point 
(K)]. The specific heat capacity of the liquid should be entered in the SHC (kJ/kg/K) textbox, and the 
latent heat of vaporisation in the Lat. Heat Vap. (kJ/kg) textbox. The viscosity of the liquid should be 
given in the Liquid Viscosity (kg/m/s) textbox, and the molecular diffusivity of the vapour in the 
Molecular Diffusivity (m²/s) textbox.

The Antoine coefficients are defined through the correlation for saturated vapour pressure as a 
function of temperature loge pv = A-B/(T+C). In LSMS the first Antoine coefficient A
(dimensionless) is eliminated by imposing the condition pv(Tboil) = pa, the atmospheric pressure, so 
that the resulting expression is loge (pv/pa) = B(T-Tboil)/{(T+C)(Tboil+C))}.

Finally, enter the molecular weight in the textbox Molecular Weight (g/mol).

To add a new component to the current liquid, choose Add from the Components menu. To delete a 
component, open the folder for that component and choose Delete from the Components menu. To 
rename a component, open the folder for that component and choose Rename from the Components
menu. You will be prompted to alter the name of the component.
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7 LSMS Error Messages

This section lists the error messages and warnings which can be generated during a simulation, with 
a brief explanation of each one and, where appropriate, some suggestions for remedial action. These 
messages appear on the screen during execution, and are also included in the log file.

ERROR MESSAGE INTERPRETATION

Filename not specified correctly on the 
command line

Either no LPL filename was passed to the simulation engine, or the 
filename was not valid.

Unable to open the file filename The LPL file could not be opened. The most common cause of this is 
an attempt to run an LPL file which does not exist.

Unable to open the user-defined source 
file filename

The SRC file containing details of the user-defined source could not 
be opened. The file may have been accidentally deleted, or the LPL 
file may have been copied to another directory without the 
corresponding SRC file. Use the interface to examine the details of 
the user-defined source.

Unable to read the spill file for 
filename

The SPL file containing details of the bund overtopping for the spill 
filename could not be read. Try opening the LPL file which you were 
attempting to run and reselecting the primary spill.

Error on opening output file One or more of the output files could not be created. This may be 
caused by an old output file having a read-only status. Try saving the 
LPL file under a new name and running the simulation again.

Truncation error giving small step Truncation errors in the numerical solution are forcing the timestep to 
become very small. This may increase the execution time for the 
simulation significantly.

Warning: too many bisections for 
temperature in FindTemp

The liquid temperature could not be determined accurately. This 
warning is unlikely in normal usage of LSMS.

Warning: no solution for Zbar after n
iterations

The vaporisation rate from the pool could not be determined. This 
warning is unlikely in normal usage of LSMS.

Internal error - … These errors should not occur in normal use of LSMS.

Error in number of modules with 
scalars

An internal error occurred while the output file was being written.

ERROR: Incorrect number of fields !! An internal error occurred while the output file was being written.

ERROR in indexing of … An internal error occurred while the output file was being written.
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8 The LSMS files

This section lists the files which make up the LSMS installation, and gives some explanation of 
what the purpose of each file is. The files are divided into four subsections: (1) programs, (2) data, 
(3) help files and (4) resources.

8.1 Program files

FILE DESCRIPTION

LSMS.EXE The LSMS interface. Run this program to use LSMS.

LSMS-16.EXE The Windows 3.1 version of the LSMS simulation engine. Carries out 
simulations.

LSMS-32.EXE The Windows 95 and Windows NT version of the LSMS simulation engine. 
Carries out simulations.

LIQEDIT.EXE The liquid database tool. Run this program to modify the database of pre-defined 
liquids.

GSW16.EXE This file is required for the graph drawing module.

8.2 Data files

FILE DESCRIPTION

LSMS.INI Contains information about your LSMS environment, such as your 
settings for the Options menu.

DEFAULT.DAT Contains the default settings for the LSMS input values. These values 
are read when the interface starts up and when you choose New from the 
File menu.

ERRORS.TXT Contains the warning messages which are logged by the simulation.

DATA\PAGELAY.TXT Contains the page layouts for printing graphs.

DATA\LIQUID.* Contain the details of the liquids in the pre-defined database (including 
newly-defined liquids).
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8.3 Help files

FILE DESCRIPTION

GRAPHPPD.HLP Help file for the graphics module.

GRAPHPPR.HLP Second help file for the graphics module.

8.4 Resources

These files provide various resources for the LSMS interface.

CMDIALOG.VBX GSWAG16.DLL

GRAPHX.VBX GSWDLL16.DLL

GRID.VBX LIPSOL.DLL

MHGMUL.VBX MHRUN400.DLL

MHTAB.VBX VBOA300.DLL

SPIN.VBX VBRUN300.DLL

THREED.VBX

TRUEGRID.VBX
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9 Files produced for each problem

9.1 A list of the files produced for each problem considered

Extension Description

LPL Main input file. Contains all input data except user-defined source details.

SRC User-defined source data. Format given in Section 9.3.

LD1 and LD2 Binary output files. Contain the detailed record of the simulation results.

LOG Log file. Record of the simulation progress.

STA Statistics file. Contains statistics on the overall simulation.

SPL Spill file. Created when the problem is selected as a primary source for a 
secondary spill. Contains details of the overtopped fluid. Format given in Section 
9.2.

ERR Error file. Created when the simulation terminates, for communication with the 
interface. Indicates whether the simulation completed successfully.

G01, G02 etc Graph files. Contain details of any graphs saved for this case.



Section 9: Files produced for each problem

- 53 -

9.2 The format of the spill file

The spill file is a text file generated by the interface when a primary file is chosen. It can be loaded 
into a spreadsheet such as Microsoft Excel. The initial part of the file gives some details of the 
primary spill. The main part contains the properties of the overtopped liquid as it enters the 
secondary domain at various times. These properties are the volume flow-rate (m³/s) 6, the velocity 
of the overtopped fluid (m/s), the depth of the fluid (m), its temperature (K), the concentration 
(volume fraction) of the components and the void fraction. The values at a given time are separated 
by tab characters. An example SPL file is shown below, with annotations explaining the meanings 
of the various parts:

Bund overtopping details for C:\PROJECTS\LSMS\TESTS\2RY\1RY-0004.LPL

Primary spill details (geometry, x0)

AXISYM,     2.05

Time (s) Vol flux (m³/s) Velocity (m/s) Height (m) Temp (K) Methane Void fraction

0 0 0 0 0 0 0

.6008021 .9613308 .5816565 8.422897E-02 106.2769 .9023081 0

.6495984 1.617334 .6219032 .119146 106.2648 .9026707 0

.699274 1.477859 .4718661 .1121937 106.2422 .9021116 0

.7505329 1.164299 .3583193 9.570238E-02 106.2842 .9023941 0

.7995006 1.060452 .3337446 .0899236 106.3137 .9031301 0

.8506654 1.066397 .3348505 9.025934E-02 106.3129 .9030689 0

.900187 1.04795 .3296396 8.921544E-02 106.301 .9029265 0

Figure 35 The SPL file format

                                                
6 Note that the flow-rates stored in this file represent the spillage over the entire bund perimeter in the primary spill. If a 
simulation is carried out for a secondary spill for which the geometry is different to that of the primary domain, the flow-
rate is adjusted appropriately during the simulation (see Section 4.1.1 (c)).

The name of the primary file

The geometry and source radius for the primary spill

Tabulated properties of the overtopped liquid
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9.3 The format of the user-defined source file

It may be useful to know the format of the user-defined source file (SRC file): for example, users 
could write programs to generate their own source files if they required the source to fit a certain 
functional form. (See Section 4.1.1 for details on entering user-defined sources using the interface.)

For a user-defined source, the user defines the time variation of flow rate, temperature and 
composition of the incoming liquid by giving the value at a set of times for each variable. LSMS 
uses these to calculate the value of each variable for the current simulated time, assuming that the 
values vary linearly between pairs of data points and remain constant at the last value once the last 
time is passed.

The SRC file is a text file which contains a list of time-value pairs for each variable defined. The 
overall structure of the file is shown in Figure 36(a). The file is divided into sections, marked by 
text strings in single quotation marks: 'FLOWRATE', 'TEMPERATURE', and 
'CONCENTRATION'. The flow-rate and temperature sections are both simply a list of time-value 
pairs. The concentration section begins with an integer indicating the number of concentrations 
which are to be specified (this will be one less than the number of components in the liquid). Then 
follows the lists of time-concentration pairs.

The format of a time-value list is shown in Figure 36(b). Each list starts with an integer, which is 
the number of time-value pairs in the list. It is important to note that there cannot be more than 250 
pairs in any list. Next follow the time-value pairs, sorted into ascending order by time. Each pair 
occupies one line and consists of a time, then a comma, then the value.

'FLOWRATE'

Time-value list for flow-rate

'TEMPERATURE'

Time-value list for temperature

'CONCENTRATION'

N-1

Time-value list for component 1

Time-value list for component 2

…

Time-value list for component N-1

(a) Schematic outline of SRC file format

n

Time1,Value1

Time2,Value2

… 

Timen-1,Valuen-1

Timen,Valuen

(b) Schematic outline of a time-value list

Figure 36 SRC file format
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10 Summary of input parameters

This section contains a brief summary in table form of all the input parameters which may need to 
be specified when setting up a run with LSMS. The default values and allowed range are given for 
each one, with some brief comments on the significance of the parameter and under which 
circumstances it should be varied from the default. The input items which are typically different 
from case to case, and so need the most attention, are marked with an asterisk (*) in the Type 
column. Parameters which are relevant for certain main options only, for example solid substrates or 
secondary sources, have a comment to this effect in the Notes column.

Users are reminded that there is a more detailed discussion of the input data in Section 4.

Each parameter occupies one row of the following tables. The information contained in each 
column is outlined below.

Parameter A brief description of the parameter.

Interface The interface textbox or other component through which the parameter is 
specified.

Default The default value for the parameter. The parameter is set to this value when 
you choose New from the File menu.

Range The range of values which is allowed for the parameter.

Type An asterisk in this column indicates that the parameter is typically different 
from case to case.

Notes Any special points which should be taken into consideration.



Section 10: Summary of input parameters

- 56 -

Parameter Interface Default Range Type Notes

CONFIGURATION

Source type Source [radio buttons] Continuous * Choose the appropriate source type for 
the case. This choice affects several other 
parameters on this folder.

Volume inflow Vol. Inflow (m³/s) 10 m³/s 0 < x  1000 m³/s * Continuous releases

Secondary width Width (m) Calculated 0  x  2000 m Secondary sources. This parameter 
should be varied if the geometry of the 
secondary region is different to that of the 
primary region. (See Section 4.1.1.) 

Secondary sector 
semi-angle

Semi-Angle (°) Calculated 0  x  180° Secondary sources. This parameter 
should be varied if the geometry of the 
secondary region is different to that of the 
primary region. (See Section 4.1.1.) 

Geometry Geometry
[radio buttons]

Axisymmetric * Choose the appropriate geometry, either 
axisymmetric (spreading equally in all 
directions or spreading into a sector) or 
planar (e.g. a spill in a channel). This 
choice affects several other parameters on 
this folder.

Transverse width of 
the flow domain

Domain Width (m) 1 m 0 < x  100 m * Planar spills.

Streamwise 
dimension for source

Source Radius (m) or 
Source Position (m) or 
Source Length (m)

6 m 0 < x  100 m * The interpretation of this depends on the 
source type: see Section 4.1.1 for details.
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Parameter Interface Default Range Type Notes

CONFIGURATION cont.

Vertical dimension 
for source

Vertical Size (m) 1 m 0 < x  100 m * The interpretation of this depends on the 
source type: see Section 4.1.1 for details.

Note that this parameter must be greater 
than the surface tension height. 

Simulation duration Duration (s) 100 s 0 < x  43200 s *

Output interval Output Interval (s) 1 s 10-3  x  1000 s * This value controls the temporal 
resolution in the output file.
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Parameter Interface Default Range Type Notes

LIQUID

Liquid type Liquid Type [list box] Methane * If the desired liquid is not among the 
options in the list box, the Liquid 
Database editor may be used to define a 
new liquid (see Section 6.5).

How the initial 
temperature of the 
liquid is defined

Set To Boiling Checked * Checked – the liquid temperature is set to 
its boiling point
Unchecked – the initial temperature is 
explicitly set by the user
Checked is recommended if the boiling 
point is below ambient temperature.

Initial temperature Initial Temperature (K) 111.67 K 0 < x  500 K * Only available if Set To Boiling is 
unchecked.

Initial composition <Component 1> conc.
<Component 2> conc.
<Component 3> conc.

1 for first 
component

0  x  1 * Specify the volume fractions of all but one 
of the components to set the initial 
composition of the liquid. 

Model bubble effects Model Bubbles Checked It is recommended that the Checked 
option is used.

Bubble rise velocity Lambda for bubbling (m/s) 0.05 m/s 0 < x  10 m/s The value of this parameter in given circumstances 
could be established experimentally, but in practice 
this information is unavailable, so it is 
recommended that the default value is used.

Vapour generation factor Bubble source term constant 1 0 < x  10 The value of this parameter in given circumstances 
could be established experimentally, but in practice 
this information is unavailable, so it is 
recommended that the default value is used.
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Parameter Interface Default Range Type Notes

SUBSTRATE

Substrate type Substrate Type Homogeneous / 
Impermeable

* Choose the appropriate substrate type.

Initial temperature of 
ground

Ground Temperature 
(K)

290 K 0 < x  1000 K * Solid substrates.

Thermal conductivity 
of bulk of substrate

Thermal Conductivity 
(kW/m/K)

1.44 x 10-3

kW/m/K
0 < x  0.01 
kW/m/K

* Solid substrates.

Thermal diffusivity of 
bulk of substrate

Thermal Diffusivity 
(m²/s)

4.92 x 10-7 m²/s 0 < x  10-5 m²/s * Solid substrates.

Specific heat capacity 
of bulk of substrate

Specific Heat Capacity 
(kJ/kg/K)

1.26 kJ/kg/K 0 < x  1000 
kJ/kg/K

* Solid substrates.

Density of bulk of 
substrate

Density (kg/m³) 2323 kg/m³ 0 < x  10000 
kg/m³

* Solid substrates.

Slope of ground 
(tangent of angle with 
horizontal)

Slope 0 –1  x  1 * Solid substrates. A positive value 
indicates slope downhill from the source. 
Modify this value to model a sloping site. 

Initial (constant) heat 
flux

Initial Heat Flux (kW/m²) 50 kW/m² 0  x  1000 
kW/m²

Spills on water. This is the constant value 
used when no ice formation modelled.

Whether effect of ice 
formation on heat 
flux is modelled

Ice Formation Unchecked Spills on water.

Final heat flux Final Heat Flux (kW/m²) 25 kW/m² 0  x  1000 
kW/m²

Spills on water with ice formation. This 
value must be less than the initial heat 
flux.
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Parameter Interface Default Range Type Notes

SUBSTRATE cont.

Absolute 
Permeability

Permeability (m²) 1 x 10-10 m² 0  x  1 * Porous substrates. This parameter can be 
measured, but in practice is often poorly 
known.

Porosity Porosity 0.4 0  x  1 * Porous substrates. This parameter can be 
measured, but in practice is often poorly 
known.

Depth of porous layer Porous layer depth 1000 m 0 < x  1000 m * Porous substrates. If the porous layer is 
effectively infinite, use the default value.

Grain size Grain size (m) 0.01 m 0 < x  0.1 m Porous substrates. It is recommended that the 
default value is used.

Relative permeability 
scale

Rel. Permeability Scale 0.25 0 < x  1 Porous substrates. It is recommended that the 
default value is used.

Conductance Conductance (/s) 1 /s 0 < x  10 /s Porous substrates. It is recommended that the 
default value is used.

Depth of upper layer Layer Depth (m) 0.1 m 0 < x  1 m * Two-layer substrates.

Thermal conductivity 
of upper layer

Thermal Conductivity 
(kW/m/K)

1.44 x 10-3

kW/m/K
0 < x  0.01 
kW/m/K

* Two-layer substrates.

Thermal diffusivity of 
upper layer

Thermal Diffusivity 
(m²/s)

1.427 x 10-6

m²/s
0 < x  10-5 m²/s * Two-layer substrates.

Specific heat capacity 
of upper layer

Specific Heat Capacity 
(kJ/kg/K)

1.26 kJ/kg/K 0 < x  1000 
kJ/kg/K

* Two-layer substrates.

Density of upper 
layer

Layer Density (kg/m³) 801 kg/m³ 0 < x  10000 
kg/m³

Two-layer substrates.
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Parameter Interface Default Range Type Notes

ATMOSPHERIC

Solar heat flux Solar Flux (kW/m²) 0.5 kW/m² 0  x  10 kW/m² * This parameter is generally only 
significant for spills of volatile liquids. 

Roughness height 
calculation method

Roughness Height 
[radio buttons]

“Rough” “Smooth” – value for wind tunnels
“Rough”  - value for practical situations 
(recommended)
“Custom” – user-specified value

Roughness height Roughness Height (m) 
[text box]

Calculated 0 < x  10 m
Only available if “Custom” is selected. 

Whether to use 
measured wind speed 
and calculate friction 
velocity

Use reference speed 
and height

Checked Uncheck this option if you intend to 
specify the friction velocity for the 
atmospheric flow explicitly. (Checked 
recommended.)

Measured wind speed Wind Speed (m/s) 5 m/s 0 < x  100 m/s *

Height at which wind 
speed was measured

Wind Height (m) 10 m 0  x  50 m *

Friction velocity Friction Velocity (m/s) Calculated 0 < x  10 m/s
Only available if Use reference speed and 
height is unchecked. If the wind speed  has 
not been measured users can specify a 
friction velocity for the atmospheric flow.
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Parameter Interface Default Range Type Notes

BUND

Whether a bund is 
present

Bund present Unchecked *

Whether liquid which 
overtops the bund 
should be modelled in 
this simulation

Model overflow Checked * This option should probably be used for 
cases in which the region outside the bund 
is similar to that inside. For more 
complicated situations, secondary sources 
can be used – see Section 4.1.1.

Distance of bund 
from source

Bund Radius (m) 50 m 0 < x  250 m * Refers to inner surface of bund wall.

This value must be greater than the source 
radius.

Thickness of bund 
wall

Bund Thickness (m) 1 m 0 < x  20 m *

Depth of bund wall Bund Depth (m) 3 m 0 < x  100 m *

Thermal conductivity 
of bund wall

Thermal Cond. kW/m/K 1.44 x 10-3

kW/m/K
0 < x  0.01 
kW/m/K

*

Density of bund wall Density (kg/m³) 2323 kg/m³ 0 < x  10000 
kg/m³

*

Thermal diffusivity of 
bund wall

Thermal Diffusivity 
(m²/s)

4.92 x 10-7 m²/s 0 < x  10-5 m²/s *
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Parameter Interface Default Range Type Notes

NUMERICAL

Run title Run Title “Default run” * This space should be used to provide a 
brief description of the problem.

Maximum number of 
timesteps for a 
simulation

Maximum No. Of 
Timesteps

2,000,000 10  x 
10,000,000

This number may need to be increased for 
very long runs – see Section 4.6.2.

Maximum number of 
grid points used for a 
simulation.

Maximum No. of Grid 
Points

200 10  x  800 This number may need to be increased to 
increase the smoothness of the solution.

Time resolution Time Resolution 1 0.5  x  6 This number may need to be increased to 
increase the smoothness of the solution. It 
can also be decreased to reduce the 
runtime of the simulation, but at the user’s 
own risk.

Spatial resolution Spatial Resolution 1 1  x  10 This number may need to be increased to 
increase the smoothness of the solution.

Front treatment Front treatment “Surface Tension” “Constant Froude Number” – the Froude number at 
the front remains constant throughout the 
simulation.

“Surface Tension” – surface tension effects are 
modelled.

Basic Froude number for 
the front

Basic Froude 1.4 0 < x  10 Comparisons with data suggest that this Froude 
number should be in the range 1.2-1.4.
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Parameter Interface Default Range Type Notes

NUMERICAL cont.

Minimum height (surface 
tension effects)

Surface Tension Height (m) 0.003 m 0 < x  0.1 m Only available if Surface Tension chosen. The 
value would be expected to increase with 
roughness: 0.003 m is appropriate for average 
roughness.

Note that this parameter must be greater than the 
minimum depth for the pool.

Turbulent drag coefficient Turbulent Drag 0.003 on water

0.01 on land

0 < x  0.05 Note that the default depends on the substrate 
chosen. It should be noted that LSMS is more 
sensitive to this parameter than to any other 
advanced parameter. The value could be varied to 
reflect the roughness of the substrate, but only with 
caution.

Include viscous shear 
stress

Include viscous shear stress Checked If this effect is included, the value of the kinematic 
viscosity of the liquid is used.

Minimum depth for the 
pool

Dry-out depth (m) 1 x 10-6 m 0 < x  0.01 m The pool is deemed to have vanished at a point 
once the depth there falls below this value.

Whether the time 
resolution should be 
modified during the run

Modify timestep during run? Unchecked Use this facility to fine tune modification of the 
timestep during the run. This allows the time 
resolution to be altered at any point during the run, 
not just at the start.

Timestep multiplier to use 
during the run

Timestep Multiplier 0.125 0 < x  2 Only available if Modify timestep during run? is 
checked. 

Timestep number after 
which the multiplier 
should be used

Use After Step 1000 0  x  10,000,000 Only available if Modify timestep during run? is 
checked.


